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HOW TO: Create a survey in Survey123

The following instructions are a step by step guide to creating an example of an environmental
quality survey.

Creating the Survey
i.  Goto https://survey123.arcgis.com/ and sign in using your school ArcGIS Online credentials.

Important -You will need to have at least a Publisher or Pupil basic User role in ArcGIS Online
to create surveys.

ii. You will then be presented with a My Surveys page. To get started with creating a new
survey click on the Create a New Survey button at the top of the page.
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[ < Create a New Survey )
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iii.  Select the Get Started option under Using the web designer

Create a New Survey

Using the web designer Using Survey123 Connect

» Get started quickly « Using a desktop application

+ Best for simple surveys « Full smart form capabilities

+ Author your survey graphically « Author through XLSForms (spreadsheet)
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iv. Fill in appropriate Name, Tags and Summary for you Survey and add a thumbnail if desired
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Create a New Survey ><

Thumbnail Name *

Environmental Quality Survey

Tags *

Environmental Quality Survey, Fieldwork, Year 8

Summary

A survey to be used by the pupils to record various environmental
quality factors during fieldwork expedition|

Create Cancel

& Show other options

v.  You will then be taken to the builder for your survey as below:

Environmental Quality Survey Overview | Design | Collaborate  Analyze  Data
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Commeon Questions

Environmental Quality Survey
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The right-hand panel provides you with the types of questions you can Add to the survey;
the ability to Edit questions that are within the survey; change the Theme and some
Settings.

To add any question to the survey, just drag the chosen question from the right-hand list to
the location that you want the question to appear in the survey.

Adding questions to your survey.
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1. Site Name

This will be a Singleline Text option. Once this question is dragged and docked onto the
survey the options to edit this question will appear on the right. Type your question here
(see below):

Environmental Quality Survey Overview ( Design ) Collaborste  Analyze Data 0

] - Lom

Environmental Quality Survey

Singleline Text

1 Site Name ©

Ticking the ‘This is a required question’ box means that the student must fill this out to
be able to submit the survey. The ‘Cache answer to this question’ option means that the
survey remembers the entry for this field and will auto-refill on the next survey filled in
by the student on this device. This enables an easier and quicker filling out of survey for
the student.

Click Save

2. Environmental Quality Score (EQ Score)

This question could be filled in with a variety of question types. For example:
- Single Choice

Here the EQ Score is selected from a list of radio buttons. Enter in the Choices you

want as options to pick. To add a new choice click on the ®
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Environmental Quality Survey
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Environmental Quality Survey Single Choice
A survey to be used by the pupils to record various envirenmental quality facters during Labe!
fieldwork expeditin
Enviranmental Qualy Score (EQ Score
1 Site Name ~
Choices Batch Edit
2 Environmental Quality Score (EQ Score) @
1 2 3 4 5 @
E=- @
8 @
[c]

Add Other Choice| Othe:

Appearance

- Rating
With this option the user can provide a rating (e.g. 5 stars) as an EQ Score. Choose
how many values can be picked and the icon style you want.

@ 7’ ® |

Add Edit Theme Settings

Environmental Quality Survey Rating

A survey to ba used by the puplls to record various environmental quality factors during Labe
fieldwork expeditin

1 Site Name " Hin
Style
2 Environmental Quality Score (EQ Score) *

Aa: lue
) B (o) (en)

Default value

E=n N
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Validation

| This is a required question

Other

Cache answer ta this question @

- Dropdown
Here the user selects the value for the EQ Score from a dropdown list of however

many values you wish. Again to add more values click on the C]
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Add Edit Theme Settings
Environmental Quality Survey Dropdown
A survey to be used by the pupils to record various environmental quality factors during Lobel
fieldwork expeditin
me [+ e (EQ ]
1 SiteName® Hint
Choices Batch Edit
2 Environmental Quality Score (EQ Score) ™ i . [C]
@
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Add Other Choice| Other

Validation

| Thisis a required question

Other

Go back to Add and click and drag the question type you would like to be underneath
the Site Name question and drop it there.

Click Save

3. Decibel reading

This question requires a Number question type as decibel reading are numerical. This will
enable you to represent the results as proportional symbols.

Environmental Quality Survey Overview | Design ) G Data
® Vd ® 3|
Add Edit Theme Settings
Environmental Quality Survey Number
A survey to be used by the pupils to record various environmental quality factors during Label

fieldwork expeditin

1 SiteName ™ Hint

Default Value

2 Environmental Quality Score (EQ Score) *

Validation
1 v ]
3 Decibel reading *
g w .
~
Other

Cache answer to this question @

Click Save
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4. How does this place make you feel?

As this option could be answered by more than one sentence we will use a Multiline
Text option.

Environmental Quality Survey

ew ( Dasign ) Collsborate  Anahze Data =<
@ ’ ® )
Add Edit Theme Settings
Environmental Quality Survey
A survey 1o be used by the puplls 1o record various envirsamentsl quality factors during Multiline Text
fieldwork expeditin
How dosa this place make you feer?
1 Site Name *
Hint
Defauit Valus
2 Envirenmental Quality Score (EQ Score)
) Validation
3 Decibel Reading *
This s a req

4 How does this place make you feel?

a Other

Click Save

If you obtain more than 20 results from this question you will be able to create a word
cloud via www.survey123.com to pull out key words used e.g.
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5. Plot location

Using the GeoPoint question type to allow the user to plot the location of the survey in a

map. Select “This is a required question” to have the map appear automatically in the
survey.
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Environmental Quality Survey

te Anslyze  Dat <
o
3 Declbel Reading * [©) V4 & o)
Add Edit Theme Settings
Lot
4 How does this place make you feel?
Defautt Map
s Plotlocation*
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LB | This s a required question
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Click Save
6. Take a picture of the place
Add an Image question to the survey
Environmental Quality Survey Overviow ( Design ) Collaborate  Analyze Data =<
” = ® 7 @ @
Add Edit Theme Settings
Image
5 Plotlocation *
m um!g =2 "M“‘!\uﬂyfmhuﬂi L)
® SR o ;
@ Lat:54.68 Lon: -2.832 4
a' Picture of the area
g m]

Click Save

If you want to edit the details of any of the existing questions just select the question from
the survey and it will produce the Edit tab for that question.

vi. Now that all of the questions are in place we can go to the Theme tab on the top right-hand
side. Pick which colour or image you would like to design the survey with.
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vii.  Then go to the Settings tab and enter in an appropriate message to be presented once the
survey is completed by the student. Decide here if you want the student to be able to add
more than one survey by ticking or unticking the ‘Allow the respondent to add another
record.

viii. Now we can Save, and finally Publish the survey to make it available for download to the
Survey123 app.

Sharing the survey with colleagues and students

If you would like other people to get access to your survey so that they can add data to it, you will
need to share the survey with them. The easiest way to do this is to share the survey to your
Organisation (your school) or to specific Groups in your account. To do this click on the Collaborate
button and choose Organisation an/or a Group if you have any set up.

This means that anyone that can log in to your ArcGIS Online account will be able to down load the
survey to their phone via the Survey123 app.

Downloading a survey

Ensure the Survey123 app is downloaded onto the devices that you or your students will be using
during fieldwork. The application can be found if you search for Survey123 for ArcGIS in the App
Store and Google Play Store.

Once the app is installed you can download the survey onto the device. To do this follow these steps:

i Open up Survey123 on the device and login with your school ArcGIS Online account
details.

My Surveys —

L)

Q

Environmental

Quality Survey

ii. Click on the icon of the three white lines in the top right hand corner to reveal the panel
below and click on Download Surveys
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&Y, Download Surveys

i®. # Settings

Sign out Jessica
: Wynne
Environm

Quality S 0 About

Download Surveys

Search

This will open a list of surveys available for download. Search for the title of your survey
and once found click on the Blue cloud icon with the green arrow to download.
<
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Environmental Quality Survey

survey download completed

Collecting data

This section will detail how to fill in and submit a survey.
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i Back on the homepage click on your survey and when inside of the survey lick on Collect
to open up the questions.

- = N f—
< Environmental Quality Survey s
—

19
Collect >
Start collecting data
Sent N
Review sent survey data

ii. Remember to fill in all questions that have a red asterix (*) next to it or when you come
to submit the survey you will receive the following message.

This is a required question - Site
Name

(o )

iii. Once all necessary questions are filled out press the tick button in the bottom right hand
corner and you will be presented options dependent on your devices connectivity.

10
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i. Online
Here you can either submit the survey, save it for later or continue to edit the
survey.

Survey Completed
Your device is online

Would you like to send the survey now?

Send Later

Send Now

Continue this survey

Using the data

i. Visit https://survey123.arcgis.com/surveys and log in with your ArcGIS Online credentials

ii. Click on survey in question

iii. On the Overview tab of the survey you will see information about how many people have
submitted surveys and when

Survey123 for ArcGIS - MySurveys  Help Jessica v

Environmental Quality Survey ( Overview ) Design  Collaborate  Analyze  Data <

First created on: Jun 21,2017

The survey is private now. No one except you can submit data to the survey.

Total Records Total Participants First Submitted On Last Submitted On

Surveys Count: 2 (Total: 2) [ 621717 - 6721717

0
15:00 16:00 17:00 18:00 19:00 20:00 21:00 22:00 23:00 00:00 01:00 02:00 03:00 04:00 05:00 06:00 07:00 08:00 09:00 10:00 11:00 12:00 13:00 14:00

iv. Further information about the data recorded can be seen on the Analyze tab. Here there are
some interesting ways of investigating the information recorded. Once you have at least 20
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submissions you can create Word Clouds from text answers e.g. how does this place make
you feel. Numeric data can be viewed in Column, Bar, Pie and Map views.

v. Finally, the Data tab allows you to download the data onto a CSV, Shapefile or File
Geodatabase. Or you can open the data into a Map Viewer and Symbolise or analyse further.

Further help on creating your own Survey123

https://doc.arcgis.com/en/survey123/browser/create-surveys/createfirstsurvey.htm

https://www.youtube.com/watch?v=ifaSlJ6BYr4&amp;index=1&amp;list=PLGZUzt4E402L7h2PdpL7s
t93nURZAWS58d
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